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Safety Information 

The CYW920819EVB-02 Evaluation kit is intended for use as a development platform for hardware or software in a 
laboratory environment. The board is an open-system design, which does not include a shielded enclosure. Due to this 
reason, the board may cause interference to other electrical or electronic devices in close proximity. In a domestic 
environment, this product may cause radio interference. In such cases, take adequate preventive measures. Also, do not 
use this board near any medical equipment or RF devices.  

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its 
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable 
mitigating measures must be taken.  

 

 

 

CYW920819EVB-02 evaluation board contains electrostatic discharge (ESD)-sensitive devices. 
Electrostatic charges readily accumulate on the human body and any equipment and can discharge 
without detection. Permanent damage may occur on devices subjected to high-energy discharges. 
Proper ESD precautions are recommended to avoid performance degradation or loss of functionality. 
Store unused CYW920819EVB-02 in the protective shipping package. 

 

 

End-of-Life/Product Recycling 

This kit has an end-of-life cycle of five years from the year of manufacturing mentioned on the back 
of the box. Contact your nearest recycler for discarding the kit. 

 

General Safety Instructions 

ESD Protection  

ESD can damage boards and associated components. Cypress recommends that you perform procedures only at an ESD 
workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap 
attached to the chassis ground (any unpainted metal surface) on the board when handling parts. 

Handling Boards 

CYW920819EVB-02 evaluation boards are sensitive to ESD. Hold the board only by its edges. After removing the board 
from its box, place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over 
any surface. Any physical action on CYW920819EVB-02 such as changing wires, jumper settings, or measuring voltages 
can cause stress on the CYW920819EVB-02 printed circuit board assembly (PCBA). You must ensure that the PCBA has 
proper support on the bottom side to avoid stress on the PCBA when the EVB is in operation.  
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1 Introduction 

Thank you for your interest in the CYW920819EVB-02 Evaluation Kit. CYW920819EVB-02 enables customers to evaluate 
and develop single-chip Bluetooth and Bluetooth Low Energy (BLE) applications using the CYW20819, dual-mode Bluetooth 
5.0 (BLE and BR/EDR) wireless MCU. 

CYW920819EVB-02 can be used with ModusToolbox™ software to develop and debug your CYW20819 project. The EVB 
offers footprint-compatibility with Arduino™ shields. The development environment is compatible with Windows, macOS 
and Linux operating systems. In addition, the kit features an onboard programmer and USB-UART chip. The EVB supports 
1.8 V and 3.3 V operation. 

Note:  This document applies to ModusToolbox software 1.1 (or later). 

The EVB is available through the Cypress Online Store or through our distributors. 

1.1 CYW920819EVB-02 Kit Contents 

The Evaluation Board (EVB) includes the following: 

 CYW920819EVB-02 evaluation board 

 USB 2.0 Type-A to micro-B cable 

 Quick Start Guide 

Figure 1-1. CYW920819EVB-02 Kit Contents 

Inspect the kit contents. If you find any part missing, contact your nearest Cypress sales office for assistance: 
www.cypress.com/support. 

http://www.cypress.com/cypress-store
http://www.cypress.com/support
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1.2 CYW920819EVB-02 Evaluation Board Details  

Figure 1-2 shows CYW920819EVB-02 evaluation board with the following features: 

1. CYW20819 carrier module with on-board antenna* 

2. Expansion headers compatible with Arduino shields 

3. Support for 1.8 V, 3.3 V and coin cell operation of the CYW20819 device  

4. Recovery button (Red), Reset button (Blue) and User button (Black) 

5. On-board micro-USB connector (J6) for programming and debug purposes 

* Note: The carrier module overhanging from the baseboard is subject to damage if handled incorrectly. 

The micro-USB connector (J6) supports UART connections and provides +5 V power to the board. See Jumpers and 
Buttons and Switches for complete information on DIP switches and jumper settings. 

Do the following before connecting the board and verifying the driver installation:  

1. Verify that all the jumpers are in default configuration as shown in Table 2-1 to Table 2-6, so that Peripheral UART 
is selected and can display embedded application trace messages. Figure 1-2 shows the default jumper locations. 

2. Connect USB connector (J6) of the WICED evaluation board to the development PC with the provided USB cable.  
The USB UART driver should load automatically. If the evaluation board is not detected as an USB device, see 
the readme.txt file in in ModusToolbox installation directory depending on the OS platform. 

For Windows and macOS: <install>\tools\wiced-tools-1.0\drivers\readme.txt. 

For Linux: <install>\tools\wiced-tools-1.0\install_driver\readme.txt. 

 

Figure 1-2. CYW920819EVB-02 Evaluation Board 

 LEDs shows the CYW920819EVB-02 with the following features: 

The LEDs labelled on the board serve the following purposes: 

 D6 (Green) indicates that VDD3P3 (3.3 V) power is ON 

 D7 (Red and Green) indicates HCI UART activity 

 D11 (Red and Green) indicates peripheral UART activity 

 D1 (Yellow) and D2 (Red) are generic user LEDs controlled by GPIOs 
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Figure 1-3. CYW920819EVB-02 Evaluation Board LEDs 

1.3 ModusToolbox 

ModusToolbox is a free software development ecosystem that includes the ModusToolbox IDE, BT_20819A1 SDK, and the 
PSoC 6 SDK to develop applications for Cypress IoT products. ModusToolbox IDE is a multi-platform, Eclipse-based 
integrated development environment (IDE) used to create new applications, update application code, change middleware 
settings, and program/debug applications. 

Using ModusToolbox IDE, you can enable and configure device resources, middleware libraries; write C source code; and 
program and debug the device. The IDE does provide hooks for launching various tools provided by the SDK, called 
BT_20819A1 SDK. 

The BT_20819A1 SDK provides the central core of the ModusToolbox software for creating Bluetooth applications. It 
contains configuration tools, drivers, libraries, middleware, make files, as well as various utilities, and scripts. You may use 
these tools in any development environment you prefer.  

For detailed information on ModusToolbox installation and usage, see the ModusToolbox IDE User Guide. 

1.3.1 ModusToolbox Code Examples 

ModusToolbox includes many code examples. Many of these code examples are compatible with this kit. You can either 
browse the collection of starter applications during application set up through File > New > ModusToolbox IDE Application 
or browse the collection of code examples on Cypress’ GitHub repository. See Figure 1-4 and Figure 1-5 for details. 

http://www.cypress.com/
http://www.cypress.com/ModusToolboxUserGuide
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Figure 1-4. Code Examples in ModusToolbox IDE 

 

Figure 1-5. Searching for Online Code Examples in ModusToolbox IDE 

1.3.2 Related Code Examples 

You can also access the kit code examples from the GitHub repository. The CYW920819EVB-02 evaluation board is pre-
programmed with the Environment Sensing Profile (CE226300 – BLE Environment Sensing Temperature with CYW20819) 
code example out-of-the-box.  

This code example is available in ModusToolbox as shown in Figure 1-4.  For the most recent version of the code example, 
check the GitHub repository. You can find the CE226300 code example in CYW920819EVB-02/apps/demo/ 
env_sensing_temp.  

https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox-1.1
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox-1.1
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For more details on the functionality, design and implementation of the code example, see the code example document 
present in the same folder as that of the code example. To import the recent version of the GitHub code examples into 

ModusToolbox, see the ModusToolbox User Guide document (Help > ModusToolbox IDE Documentation > User Guide). 

1.3.3 ModusToolbox Help 

Launch ModusToolbox and navigate to the following items: 

• Quick Start Guide: Choose Help > ModusToolbox IDE Documentation > Quick Start Guide. This guide gives you 
the basics for using ModusToolbox IDE. 

• ModusToolbox General Documentation: Choose Help > ModusToolbox General Documentation > 
ModusToolbox Documentation Index. This page provides link to various ModusToolbox documents. 

• ModusToolbox IDE User Guide: Choose Help > ModusToolbox IDE Documentation > User Guide. This is a 
comprehensive guide for creating, building, and programming ModusToolbox applications. 

• WICED API Reference: Choose Help > ModusToolbox API Reference > WICED API Reference. This page 
provides WICED Bluetooth API Reference Guide. 

1.4 Getting Started 

This user guide will help you find details of the CYW920819EVB-02 Evaluation Kit: 

 The Kit Operation chapter describes the operation of the kit and how to use its various features. 

 The Hardware chapter describes the design details of the CYW920819EVB-02 hardware blocks. 

1.4 IoT Resources and Technical Support 

Cypress provides a wealth of wireless product documentation at www.cypress.com/products/wireless-connectivity to help 
you to select the right IoT device for your design. In addition, a professional community at 
community.cypress.com/community/wireless supplies developers the latest software and tools to solve common evaluation 
and integration problems while interacting directly with both Cypress engineers and experienced peers. 

1.5 Additional Learning Resources 

Visit the CYW920819EVB-02 webpage for additional learning resources including datasheets and application notes. 

1.6 Document Conventions 

Convention Usage 

Courier New Displays source code examples. 

Consolas 
API and function names (when mentioned within body text) 

The WICED_BT_TRACE() macro can  be used to generate printf-style messages from the 

application code. 

Italics 
Displays file names, file locations, and reference documentation: 

C:\ ...cd\icc\ 

File > Open 
Represents menu paths: 
File > Open > New Project 

Bold 
Displays commands, menu paths, and icon names in procedures: 
Click the File icon and then click Open. 

Times New Roman 
Displays an equation: 
2 + 2 = 4 

Text in gray boxes Describes Cautions or unique functionality of the product. 

Table 1-1. Document Conventions 

 

 

http://www.cypress.com/products/wireless-connectivity
https://community.cypress.com/community/wireless
http://www.cypress.com/CYW920819EVB-02
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1.7 Acronyms 

Acronym Definition 

ADC Analog to Digital Converter 

API Application Programming Interface 

BR Basic Rate 

BT / BLE Bluetooth / Bluetooth Low Energy 

EEPROM Electrically Erasable Programmable Read-Only Memory 

EM Electro-magnetic 

ESS Environment Sensing Service 

EVB Evaluation Board 

GAP Generic Access Profile 

GATT Generic Attribute Profile 

GPIO General Purpose Input Output 

HAL Hardware Abstraction Layer 

HCI Host Controller Interface 

I2C Inter-Integrated Circuit 

IDE Integrated Development Environment  

JRE Java Runtime Environment 

JTAG Joint Test Action Group 

LE Low Energy 

LED Light Emitting Diode 

LHL Lean High Land 

LPO Low Power Oscillator 

MEMS Micro Electro-Mechanical System 

NTC Negative Temperature Coefficient 

PCB Printed Circuit Board 

PUART Peripheral UART 

PWM Pulse Width Modulation 

RF Radio Frequency 

SDK Software Development Kit 

SIG Special Interest Group 

SoC System-On-Chip 
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Acronym Definition 

SPI Serial Peripheral Interface 

SWD Serial Wire Debug 

UART Universal Asynchronous Receiver/Transmitter 

USB Universal Serial Bus 

WICED Wireless Internet Connectivity for Embedded Devices 

XTAL Crystal Oscillator 

Table 1-2. List of Acronyms used in this Document 
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2 Kit Operation 

This section provides detailed instructions to set up the Cypress CYW920819EVB-02 evaluation board to use with Cypress 
ModusToolbox for Bluetooth Classic (aka BR - Basic Rate and EDR – Enhanced Data Rate) and Low Energy (LE) 
applications.  

This chapter introduces you to the CYW920819EVB-02 and the features that will be used as part of the kit operation. This 
chapter also discusses features such as the Bluetooth connectivity and programming/debugging as well as the USB-UART 
bridge device that can be used to communicate with the CYW20819-A1 device on this EVB. 

2.1 Theory of Operation 

The CYW920819EVB-02 is built around the CYW20819-A1 device. Figure 2-1 shows the block diagram of the CYW20819-
A1 device. See the device datasheet for details on device features. 

 

 

Figure 2-1. Block Diagram of CYW20819-A1 

  

https://www.cypress.com/datasheet/CYW20819


 

 Kit Operation    

CYW920819EVB-02 Evaluation Kit User Guide, Document Number: 002-26340 Rev. ** 12 

Figure 2-2 illustrates the block diagram of CYW920819EVB-02. This board contains a CYW20819-A1 Bluetooth SoC and 
a USB-Serial interface/programmer. The kit features Arduino form-factor-compatible headers, which enable Arduino shields 
to be plugged in, extending EVB’s capabilities. It also features one user switch, one reset switch, one recovery switch, two 
user LEDs, a thermistor, and a motion sensor. 

 

Figure 2-2. Block Diagram of CYW920819EVB-02 

Figure 2-3 and Figure 2-4 show the markup of the CYW920819EVB-02 evaluation board. See the list below for a description 
of the numbered items. 

  

Figure 2-3. CYW920819EVB-02 Evaluation Board (Top View) 
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Figure 2-4. CYW920819EVB-02 Evaluation Board (Bottom View) 

1. HCI UART Header (J5): This header can be used to connect or disconnect HCI UART from the USB-Serial device. 

2. Motion Sensor (U2): This is an I2C-based 9-axis inertial motion sensor. 

3. VDDIO Select Jumper (J7): This header is used to select the VDDIO power source. Possible selections are 3.3 V, 1.8 
V, or VCOIN, which is the coin cell power supply on the bottom side of the board. 

4. USB Connector (J6): J6 is a micro-B USB female connector for connecting the kit to PC using the provided USB cable. 
It is used for programming and USB-UART communication. 

5. VBATT Select Header (J8): This header is used to select the VBATT (Core power supply) power source. The possible 
selections are 3.3 V, 1.8 V, or VCOIN which is the coin cell power supply on the bottom side of the board. 

6. VPA_BT Select Header (J16):  This header is used to select the VPA_BT (Power Amplifier supply) power source. This 
select header applies to evaluation boards that has an external power amplifier and it is not connected to CYW20819 
in CYW920819EVB-02 evaluation board. 

7. PUART Header (J10): This header can be used to connect or disconnect the PUART pins from the USB-Serial device. 

8. SWD/GPIO Switch (SW9): This DIP switch allows you to route the functionality of GPIO/SWD lines to either J4 Arduino-
compatible header or the J13 debug header.  

9. Debug Header (J13): J13 is a 10-pin interface header that can be used to connect an external debugger via SWD.  

10. Thermistor (R30): The onboard thermistor is an NTC analog thermistor that can be used to measure temperature. 

11. Thermistor Enable Header (J14): This jumper can be used to connect or disconnect the on-board thermistor from the 
CYW20819 device. 

12. Peripheral Enable (J18): The jumper allows the user to disconnect the VDDIO supply to onboard peripheral devices 
like motion sensor, thermistor, analog mic and real-time clock by disabling VDDP.  

13. EXT_LPO Enable Jumper (J19): This jumper is open by default. When the jumper is closed, the RTC (G1 in 
schematics) provides a 32.768-kHz clock source to the CYW20819’s EXT_LPO pin. When the jumper is open, the Y2 
crystal provides 32.768-kHz to XTAL_32K(I/O) pins of CYW20819. To use the EXT_LPO instead of Y2 crystal, the user 
needs to remove the entire Y2 circuit which includes R6, Y2, C19 and C20 and populate R7 with zero-ohm resistor. 
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14. VDDIO Current Measurement Header (J15): This jumper is used to power the carrier module. To measure the current 
consumed by the carrier module, remove this jumper and connect an ammeter to the two pins. 

15. Recovery Button (SW1): This button is used to put the device in recovery mode. To put the device in recovery mode, 
press and hold the recovery button, press and release the reset button, and then release the recovery button. The user 
may need to put the device in recovery mode when the application download fails. 

16. Arduino Compatible Header (J11): The Arduino-compatible I/O header brings out pins from CYW20819 to interface 
with Arduino shields. 

17. Reset Button (SW2): This button can be used to reset the device. 

18. Arduino Compatible Header (J12): The Arduino-compatible I/O header brings out pins from CYW20819 to interface 
with Arduino shields. 

19. User Button (SW3): This button can be used to provide an input to the CYW20819 device. Note that the button 
connects the CYW20819 pin to ground when pressed; therefore, the CYW20819 pin must be configured as a digital 
input with resistive pull-up for detecting the button press. 

20. User LEDs (D1 and D2): These on-board LEDs can be controlled by the CYW20819 device. The LEDs are active 
LOW; therefore, these pins must be driven to ground to turn ON the LEDs. 

21. LED Enable Switch (SW4): These DIP switches are used to connect/disconnect the user-controlled LEDs from the 
CYW20819 device.  

22. External Antenna Connector (U1.J3):  The external antenna connector is an RF connector fed from the BT_RFIO 
pad of the CYW20819 followed by a band pass filter. See Hardware Design Guidelines for more details. 

23. PCB Antenna (A1): The PCB antenna is the EM wave radiating part of the evaluation board which is fed from the 
BT_RF pad of CYW20819 followed by a band pass filter and an antenna matching circuit. 

24. CYW20819(U1. U1): The Bluetooth (BR/EDR- Basic Rate and Enhanced Data Rate) and Bluetooth Low Energy 5 
qualified system-on-chip from Cypress is the heart of this evaluation kit. 

25. Carrier Module (U1): The carrier module has the CYW20819 SoC on it. A Bluetooth antenna is etched on the carrier 
module PCB. The UART and GPIOs are brought out from the SoC pads to interface with the baseboard.   

26. Coin Cell Holder (ZB1): This is a coin cell battery holder located on the bottom side of the development kit. If the 
evaluation board needs to use the power supplied from the coin cell, then the VDDIO and VBAT select headers must 
be set to VCOIN. 

27. 8-Mb Serial Flash (U6):  This is the 8-Mbit SPI flash used for application purpose. 

28. Arduino Compatible Header (J4): The Arduino-compatible I/O header brings out pins from CYW20819 to interface 
with Arduino shields. 

29. WICED Header (J2): This header brings out some pins of the CYW20819 device that are not connected to the Arduino 
compatible headers. These pins can be used for testing or for custom applications. 

30. Arduino Compatible Header (J3): The Arduino-compatible I/O header brings out pins from CYW20819 to interface 
with Arduino shields. 

31. WICED Header (J1): This header brings out some pins of the CYW20819 device that are not connected to the Arduino 
compatible headers. These pins can be used for testing or for custom applications. 

32. Motion Sensor Interrupt Test points (J17): This header has three test points for probing the interrupts from the motion 
sensor (U2). 

33. PUART Voltage Level Translator (U9): This voltage level translator IC allows the interoperability of devices 
(CYW20819 device and USB/Serial IC) with different high-level and low-level voltages for input and output operations. 

34. EEPROM (U10): This EEPROM contains the configuration information for the USB to UART Converter for acting as a 
USB Slave device. 

35. USB to UART converter (U8): This is a 2-channel USB to UART IC for communicating between CYW20819 and a 
PC.  

BT UART (HCIUART) Voltage Level Translator (U7): This voltage level translator IC allows interoperability of devices 
(CYW20819 device and USB/Serial IC) with different high-level and low-level voltages for input and output operations.  

 

https://www.cypress.com/documentation/application-notes/an225948-cyw2081920820-hardware-design-guideline
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2.2 Jumpers 

Table 2-1 to Table  list the jumper settings on the CYW920819EVB-02 board. 

Jumper J5 (HCI 
UART) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Shorted UART_RXD 
Connects CYW20819’s UART_RX pin to the USB-Serial chip via level 
translators for USB-to-UART functionality. 

3 and 4 Shorted UART_TXD 
Connects CYW20819’s UART_TX pin to the USB-Serial chip via level 
translators for USB-to-UART functionality. 

5 and 6 Shorted UART_CTS_N 
Connects CYW20819’s UART_CTS_N pin to the USB-Serial chip via level 
translators for USB-to-UART functionality. 

7 and 8 Shorted UART_RTS_N 
Connects CYW20819’s UART_RTS_N pin to the USB-Serial chip via level 
translators for USB-to-UART functionality. 

Table 2-1. Jumper J5 Pin Configurations 

Jumper J7 (VDDIO 
Selection) 

Default 
State 

Connection on 
CYW20819 

Description 

2 and 4 Shorted 

VDDO1, VDDO2 

Short these pins to supply 3.3 V to VDDIO of the CYW20819 device, as well 
as all peripherals and sensors. 

4 and 6 Open 
Short these pins to supply 1.8 V to VDDIO of the CYW20819 device, as well 
as all peripherals and sensors. 

3 and 4 Open 
Short these pins to supply VDDIO of the CYW20819 device, as well as all 
peripherals and sensors from the coin cell supply (VCOIN). 

Table 2-2. Jumper J7 Pin Configurations 

Jumper J8 (VBAT 
Selection) 

Default 
State 

Connection on 
CYW20819 

Description 

2 and 4 Shorted 

SR_PVDD, 
PMU_AVDD 

Short these pins to supply 3.3 V to VBAT of the CYW20819 device. Also, use 
this jumper to measure the current consumption of VBAT when using 3.3 V 
supply. 

4 and 6 Open 
Short these pins to supply 1.8 V to VBAT of the CYW20819 device. Also, use 
this jumper to measure the current consumption of VBAT when using 1.8 V 
supply. 

3 and 4 Open 
Short these pins to use the coin cell supply VBAT of the CYW20819 device. 
Also, use this jumper to measure the current consumption of VBAT when 
using the coin cell supply (VCOIN). 

Table 2-3. Jumper J8 Pin Configurations 

 

Jumper J10 
(Peripheral UART) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Open NC** 
The PUART’s RTS on the USB-Serial chip is not connected to any of the 
CYW20819 GPIOs. 

3 and 4 Open P10 
Connects CYW20819’s P10 pin as UART CTS to the USB-Serial chip via 
level translators for the USB-to-UART functionality when shorted. 

5 and 6 Shorted P32 
Connects CYW20819’s P32 pin as UART TX to the USB-Serial chip via level 
translators for the USB-to-UART functionality. 

7 and 8 Shorted P37 
Connects CYW20819’s P37 pin as UART RX to the USB-Serial chip via level 
translators for the USB-to-UART functionality. 

Table 2-4. Jumper J10 Pin Configuration 

** Note: Because PUART RTS is not routed to the FT-2232HQ-REEL chip, any of the available LHL GPIOs can be assigned 

as PUART RTS using Device Configurator Utility and connected using a jumper to the PUART (J12) header to avail the 

flow control mechanism provided by UART. 
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Jumper J14 (Thermistor 
Connect/ Disconnect) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Shorted P8 Short this jumper to connect the on-board thermistor to CYW20819. 

Table 2-5. Jumper J14 Pin Configuration 

Jumper J15 (VDDIO 
Current Measurement) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Shorted VDDIO1, VDDIO2 
Short this jumper to supply power to the I/O domain (VDDIO) of 
CYW20819. Also, use this jumper to measure the current 
consumption of the I/O domain. 

Table 2-6. Jumper J15 Pin Configuration 

Jumper J18 (Peripheral 
Enable) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Shorted NA 
This jumper allows the user to allow power to on-board 
peripherals such as motion sensor. 

Table 2-7. Jumper J18 Pin Configuration 

Jumper J19 (EXT_LPO 
Enable) 

Default 
State 

Connection on 
CYW20819 

Description 

1 and 2 Open 
XTALI_32K, 
XTALO_32K 

When the jumper is open, the Y2 crystal provides 32.768-kHz to 
XTAL_32K(I/O) pins of CYW20819. 

Table 2-8. Jumper J19 Pin Configuration 

Jumper J16 (VPA_BT 
Current Measurement) 

Default 
State 

Connection on 
CYW20819 

Device 

Description 

2 and 4 Shorted 

NC_0 
(PALDO_VDDIN) 

 

This select header applies to evaluation boards that has an 
external power amplifier and it is not connected to CYW20819 in 
the CYW920819EVB-02 Evaluation Board. 

4 and 6 Open 
This select header applies to evaluation boards that has an 
external power amplifier and it is not connected to CYW20819 in 
the CYW920819EVB-02 Evaluation Board. 

3 and 4 Open 
This select header applies to evaluation boards that has an 
external power amplifier and it is not connected to CYW20819 in 
the CYW920819EVB-02 Evaluation Board. 

Table 2-9. Jumper J16 Pin Configuration 

NOTE: VDDIO must be greater or equal to VBAT. CYW20819 uses an on-chip low voltage detector to shut down the chip 
when supply voltage (VBAT) drops below the operating range. The Shutdown Voltage (VSHUT) lies between a minimum of 
1.5 V and a maximum of 1.7 V. See the datasheet for more details. 
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2.3 Buttons and Switches 

Buttons Pressed State 
Connection on 

CYW20819 
Description 

SW1 GND RECOVER Recovery button (Red) 

SW2 GND RST_N Active LOW Reset button (Blue) 

SW3 GND P0 User application button (Black) 

Table 2-10. Button Functionality 

The DIP switch SW4 enables or disables the two onboard user LEDs. By default, both LED1 and LED2 are enabled. 

DIP SW4 Default State 
Connection on 

CYW20819 
Description 

1 ON P27 Enables LED1 

2 ON P26 Enables LED2 

Table 2-11. SW4 DIP Switches Configuration 

SW9 is a 2-pole DIP switch. Pole 1 allows P2 to be switched between the SWDCK functionality for the debugger interface 
and GPIO functionality for the Arduino-compatible header. Pole 2 allows P3 to be switched between the SWDIO functionality 
for the debugger interface and GPIO functionality for the Arduino-compatible header. When using P2 and P3 as GPIOs, 
keep SW9 in ON position. 

DIP SW9 Default State Connection on CYW20819 Description 

1 ON P2 Connects P2 to the Arduino-compatible header pin D4 if the switch 
pole 1 is in the ON state. Connects P2 to the debugger header if the 
switch pole is in the OFF state. 

2 ON P3 Connects P3 to the Arduino-compatible header D5 if the switch pole 
2is in the OFF state. Connects P3 to the debugger header if the 
switch pole is in the OFF state. 

Table 2-12. SW9 DIP Switches Configuration 

2.4 Arduino-Compatible Headers 

J3, J4, J11, and J12 are the Arduino-compatible headers.  

Header J3 Arduino PIN Connection on CYW20819 WICED Enum Name Description 

1 SCL P28 WICED_P28 I2C SCL 

2 SDA P29 WICED_P29 I2C SDA 

3 AREF NC - NC 

4 GND GND - Ground 

5 D13 P9 WICED_P09 GPIO 

6 D12 P17 WICED_P17 GPIO 

7 D11 P6 WICED_P06 GPIO 

8 D10 P15 WICED_P15 GPIO 

9 D9 NC - NC 

10 D8 P14 WICED_P14 GPIO 

Table 2-13. Header J3 Pin Configuration 
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Header J4 Arduino PIN Connection on CYW20819 WICED Enum Name Description 

1 D7 P5 WICED_P05 GPIO. 

2 D6 P4 WICED_P04 GPIO. 

3 D5 P3  WICED_P03 GPIO.  

4 D4 P2 WICED_P02 GPIO.  

5 D3 NC  NC. 

6 D2 P0 WICED_P00 User button. 

7 D1 P32 WICED_P32 PUART TX. 

8 D0 P37 WICED_P37 PUART RX. 

Table 2-14. Header J4 Pin Configuration 

Header J11 Arduino PIN Connection on CYW20819 Description 

1 IR_TX NC NC 

2 IOREF VDDIO I/O reference pin used by shields to determine 
the I/O voltage. Connected to VDDIO on this 
board. Therefore, IOREF follows 1.8 V or 3.3 V, 
or VCOIN of VDDIO. 

3 RST ARD_RST/ P1  Arduino Reset (R72 install position A) (See 
Device Reset) / P1 (R72 install position B). 

4 3V3 VDD3P3 3.3-V supply output to the Arduino Shield. 

5 5V VDD5V 5-V supply output to the Arduino Shield. 

6 GND GND Ground. 

7 GND GND Ground. 

8 VIN NC NC. 

Table 2-15. Header J11 Pin Configuration 

Header J12 Arduino PIN Connection on CYW20819 WICED Enum Name Description 

1 A0 P8 WICED_P08 GPIO/Thermistor 

2 A1 NC - - 

3 A2 P10 WICED_P10 GPIO/PUART CTS 

4 A3 NC - - 

5 A4 P12 WICED_P12 GPIO 

6 A5 P13 WICED_P13 GPIO 

Table 2-16. Header J12 Pin Configuration 

When accessing the Arduino pins, remove the jumpers that may interfere with the Arduino pins e.g. PUART jumpers, 
thermistor jumper. 
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2.5 Other Headers 

J1 and J2 are test headers which bring out certain pins of CYW20819 for testing. 

Header J1 
Connection to Header 

Pin  
Connection on 

CYW20819 
WICED Enum Name Description 

1 LED1/SF_WP P27 WICED_P27 LED1 connection. 

2 LED2/SPI_INT P26 WICED_P26 LED2 or SPI interrupt connection. 

3 BT_DEV_WAKE DEV_WAKE  Signal to wake up the device. 

4 BT_HOST_WAKE HOST_WAKE  Signal to wake up the host 

5 STATUS NC  No Connect. 

6 TX_REQ/SECI_OUT NC  No Connect. 

7 TX_CONF/SECI_IN NC  No Connect. 

8 VBATT NC  No Connect. 

9 BATT_MON NC  No Connect. 

10 GND GND  Ground. 

Table 2-17. Header J1 Pin Description 

Header J2 Connection to Header Pin  Connection on CYW20819 Description 

1 RSVD1 NC No Connect. 

2 RSVD2 NC No Connect. 

3 RSVD3 NC No Connect. 

4 RSVD4 NC No Connect. 

5 RSVD5 NC No Connect. 

6 RSVD6 NC No Connect. 

7 RSVD7 NC No Connect. 

8 RSVD8 NC No Connect. 

9 RSVD9 P11 (WICED_P11) SPI (Slave Select) External Flash Memory. 

10 RSVD10 NC  

Table 2-18. Header J2 Pin Description 

J13 is a 10-pin debugger header to debug CYW920819EVB-02 using SWD. 

Header J13 Connection to Header Pin 
Connection on 

CYW20819  
WICED Enum Name Description 

1 VDDIO VDDIO  VDDIO reference. 

2 D5/SWDIO P3 WICED_P03 Serial Wire Debug Input Output. 

3 GND GND  Ground. 

4 D4/SWDCK P2  WICED_P02 Serial Wire Debug Clock. 

5 GND GND  Ground. 

6 NC NC  No Connect. 

7 NC NC  No Connect. 

8 NC NC  No Connect. 

9 NC NC  No Connect. 

10 BT_RST RST_N  CYW20819 device reset. 

Table 2-19. Header J13 Pin Description 
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2.6 USB Serial Interface Chip 

An FT-2232HQ-REEL chip is used for onboard programming and USB-Serial functionality. It connects to the computer over 
a USB interface and connects to the CYW20819-A1 device through the HCI UART and PUART pins. 

2.7 Kit Power Supply 

The kit can be powered by one of two power sources: USB or coin cell battery. 

As shown in Figure 2-2 the USB power is connected to two Buck regulators, one regulating the voltage to 1.8 V and the 
other to 3.3 V. A coin cell battery can be directly connected without the need of a regulator. See Table 2-2, Table 2-3,  
Table 2-6, and Table 2-9 to understand the jumper settings for power selection. 

2.8 Test Points 

There are four ground test points for easy connection of probes. The voltage from various power domains can be measured 
from their respective headers (J7, J8, and J16). 

Label Description 

TP6, TP7, TP8, TP18 Test points for Ground 

Table 2-20. Ground Test Points Available in CYW920819EVB-02 

J17 is a 3-pin test point for testing 9-axis motion sensor (U2) interrupts. 

Test-Point J17 Connection to Header Pin Description 

1 INT1_A/G Interrupt 1 from Accelerometer/Gyroscope. 

2 INT2_A/G Interrupt 2 from Accelerometer/Gyroscope. 

3 INT_M Interrupt from Magnetometer. 

Table 2-21. Test Point J17 Description 

2.9 Current Measurement 

The CYW20819 device has two power domains: VDDIO to power the Lean High Land (LHL) pins and VBAT to power the 
core. The total current consumption by the device is the sum of the current consumed by the VDDIO and the VBAT domains. 
To measure the current consumed by the VDDIO domain, an ammeter can be connected across jumper J15. To measure 
the current consumed by the VBAT domain, connect an ammeter across pin 4 and one of pins 2, 3, or 6 (depending on the 
power source) of jumper J8. 

2.10 SWD Debugging 

ModusToolbox supports multiple Arm®-JTAG adapters for debugging Bluetooth products like CYW20819. Debugging is 
possible on CYW920819EVB-02 through SWD (Serial Wire Debug) signals. SWD is a two-wire interface that uses SWDIO 
(SWD Input Output) and SWDCK (Serial Wire Clock) for debugging the device. These two lines can be brought out to any 
of the LHL GPIOs on CYW20819. In CYW920819EVB-02, P2 will act as SWDIO and P3 will act as SWDCK. See Table 
2-12 to enable SWD pins to the debug connector (J13). 

After making the above hardware configurations, see the Debugger guide (<install>/libraries/bt_20819A1-
<version>/docs/BT-SDK/ WICED-Hardware-Debugging.pdf) for debugging your application using ModusToolbox.  

2.11 Pin Configuration 

GPIOs on the CYW20819 device can be multiplexed to various peripherals. For more information on the peripherals that 
can be routed to the various GPIOs, see the device datasheet.  

For this board, the ModusToolbox software initializes GPIOs to the platform default configuration. For example, P28 and 
P29 are configured as I2C SCL and I2C SDA, respectively.

https://www.cypress.com/datasheet/CYW20819
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3 Hardware 

This chapter describes the CYW920819EVB-02 hardware and its different blocks such as reset control, Arduino-compatible 
headers, and module connectors. 

The schematics for the baseboard and carrier module can be found at CYW920819EVB-02 Evaluation kit page. 

3.1 Carrier Module 

The baseboard of the CYW920819EVB-02 board is designed to be modular so that various carrier modules can be used 
with the same baseboard. In this kit, the CYW920819WCD2 carrier module, which employs the CYW20819 device, is 
soldered on the baseboard. The carrier module interface is a generic interface that can be used across may devices. See 
Appendix A for a detailed interface description. The Bluetooth antenna is etched on the carrier module PCB. UART signals 
and GPIOs are brought out to module pins to interface with the baseboard. 

3.1.1 CYW20819 
The CYW920819EVB-02 board employs the CYW20819A1KFBG device which is a 62-BGA package. This board uses all 
22 LHL GPIOs provided by the 62-BGA package. 

3.1.2 Antenna 
A PCB antenna is printed on the carrier module. This antenna is matched to 50 Ω when the CYW920819EVB-02 board is 
placed on a table. Table 3-1 lists the S11 measurement. See AN91445 – Antenna Design and RF Layout Guidelines for 
additional information. 

2402 MHz  2441 MHz  2480 MHz  

-13.2 dB -14.6 dB -12.6 dB  

Table 3-1. Antenna S11 Measurement 

3.1.3 Crystal 
The CYW20819 carrier module has two crystals onboard. A 24-MHz crystal (XTAL) is the main crystal. This XTAL must 
have an accuracy of +/-20 ppm as defined by the Bluetooth specification. A 32.768-kHz crystal provides accurate timing 
during low-power operation. See the CYW20819 datasheet for crystal requirements. 

3.1.4 External Serial Flash 
The CYW20819EVB has an 8-Mbit serial flash on the baseboard, which can be useful when the user application requires 
more memory. The GigaDevice GD25WD80CEIG is the 8-Mbit serial flash used in CYW920819EVB-02. The BT_20819A1 
SDK is compatible with most of the JEDEC CFI-compliant SPI flash ICs. The SPI driver should configure the respective 
pins in the user application in order to use the on-board serial flash. 

 

Figure 3-1. External Serial Flash 

http://www.cypress.com/documentation/development-kitsboards/cyw920819evb-02-evaluation-kit
http://www.cypress.com/documentation/application-notes/an91445-antenna-design-and-rf-layout-guidelines
https://www.cypress.com/datasheet/CYW20819
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3.2 Baseboard 

CYW9BTWCDEVAL4 is a baseboard on which the CYW20819 carrier module is soldered. 

3.3 Serial Communication Between CYW20819 and FT2232HQ-REEL 
USB-Serial Device 

The onboard FT2232HQ-REEL device is a two-channel USB-Serial converter. The USB-serial pins of the FT2232HQ-REEL 
device is hard-wired to the HCI UART and PUART pins of the CYW20819 device. An EEPROM device is connected to the 
FT2232HQ-REEL USB-Serial device to store its configuration. Because PUART RTS is not routed to the USB-Serial device, 
any of the available LHL GPIOs can be assigned as PUART RTS using Device Configurator Utility and connected using a 
jumper wire to the PUART header to avail the flow control mechanism provided by UART.  

NOTE: For applications involving low power modes, the CYW920819EVB-02 evaluation board needs to be reset after 
plugging it into the computer. This is due to the behavior of the serial communication chip where it asserts the CTS pin for 
some time on power-up which prevents the CYW920819EVB-02 evaluation board to go the low power mode. 

3.4 Power 

The power supply system on this board is versatile, allowing the input supply to come from the following sources: 

 1.8 V or 3.3 V from the onboard USB connector. 

 3 V from a coin cell battery. 

Figure 3-2 shows the power architecture of the evaluation board. 

  

Figure 3-2. Power Architecture 
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Power supply options can be selected via jumper settings on J7, J8, and J16. See Table 2-2, Table 2-3, and Table 2-9 for 
the different jumper settings for J7, J8, and J16. Resistors R25 and R21 are the pull-up resistors for I2C lines to the motion 
sensor i.e., SCL and SDA. Note that J18 (PERIPH ENABLE) should be shorted for any I2C devices to be connected because 
the pull-up voltages for SCL and SDA are supplied from VDDP. The VPA_BT selection jumper (J16) applies to evaluation 
boards that have an external power amplifier and it is not connected to CYW20819 in CYW920819EVB-02 Evaluation Kit. 

 

Figure 3-3. 5-V Power Supply from USB 

 

Figure 3-4. 3.3-V Regulator Circuit 
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Figure 3-5. 1.8-V Regulator Circuit 

 

 

Figure 3-6. Jumper J7 for VDDIO Selection 

 

Figure 3-7. Jumper J8 for VBAT Selection 

 

Figure 3-8. Jumper J16 for VPA_BT Selection (NC) 
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3.5 Device Reset 

The reset circuit on the board consists of a Reset button (SW2) connected to ground and a voltage detector IC. The RST_N 
pin on CYW20819 should be released after 50 ms or more after the VDDIO supply voltage has stabilized. The voltage-
detector IC is used to provide this delay. 

  

Figure 3-9. Reset Button Circuit 

 

Figure 3-10. Voltage Detector Circuit in the Carrier Module 

The reset button (SW2) always connects to the BT_RST input on the device so that the device can be reset by pushing the 
button. 

In the default configuration of R72 shown below (position B-C), device pin P1 will be routed to the ARD_RST header so the 
reset button will not trigger the Arduino-compatible header reset pin, but device pin P1 can be used to monitor or drive the 
Arduino-compatible header reset pin. 

When R72 is in position (B-C), the reset button is routed to the Arduino-compatible header reset pin in addition to the device, 
so both the device and shields can be reset by pressing SW2. Alternatively, in this case, the device can be reset by driving 
the Arduino-compatible header reset pin LOW allowing for an external reset source. 

 

Figure 3-11. Reset to Arduino-Compatible Header 
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3.6 Thermistor 

The thermistor circuit is a simple voltage divider circuit consisting of an NTC thermistor that is 100 kΩ at 25 °C and a fixed 
100-kΩ resistor. The divided voltage is fed in to A0 and the voltage level determines the ambient temperature. The part 
number of the thermistor used on this kit is NCU15WF104F60RC. 

 

Figure 3-12. Thermistor Circuit 

3.7 Motion Sensor 

CYW920819EVB-02 has an onboard 9-axis motion sensor (STMicroelectronics LSM9DS1). It has three acceleration 
channels, three angular rate channels, and three magnetic field channels. The CYW20819 device communicates with this 
sensor over I2C. The I2C address to access the accelerometer and gyroscope is 0xD4 and to access the magnetometer, 
the address is 0x38. The sensor supports 100-kHz and 400-kHz speeds. See the LSM9DS1 datasheet to understand how 
to access the registers. 

 

Figure 3-13. Motion Sensor Circuit 
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3.8 LEDs 

There are two onboard user LEDs on this kit. LED1 is controlled by P27. LED2 is controlled by P26. You can enable or 
disable the LEDs using the DIP switch SW4. See Table 2-11 for DIP switch configuration. TLMY1000-GS08 (Yellow) from 
Vishay Intertechnology requires a typical voltage of at least 1.8 V (can be as high as 2.6 V) to operate. LTST-C190CKT 
(Red) from Lite-On Technology Corporation requires a typical voltage of at least 1.8 V (can be as high as 2.4 V) to operate.  

Note: LEDs are initialized by default on bootup. See the following file for the LED enumeration in the SDK: 

<install>\libraries\bt_20819A1-<version>\components\BT-SDK\20819-A1_Bluetooth\platforms\CYW920819EVB_02\wiced_platform.h 

 

Figure 3-14. LED Circuit 

3.9 Push Buttons 

CYW920819EVB-02 has a reset button, recovery button, and a user button. See the Device Reset section for details on the 
reset button. See the Buttons and Switches section for details on using the recovery button during kit programming. One 
user button (SW3) is connected to the P0 pin of the CYW20819 device. 

Note: The user button is initialized by default on bootup. See the <install>\libraries\bt_20819A1-<version>\components\BT-

SDK\20819-A1_Bluetooth\platforms\CYW920819EVB_02\wiced_platform.h file for button enumeration in the SDK.
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Appendix A.  CYW20819 Device I/O Mapping 

Table A.1 maps the CYW20819 device I/Os to headers and sensors on the baseboard. It also lists the carrier module 
interface definition. 

** Note: The on-board MIC1 is not supported in CYW20819 BGA62 package. 

Carrier 
Module 

Pin 
Carrier Module Pin Name CYW20819 Pin 

Baseboard 
Connection 1 

Baseboard 
Connection 2 

Baseboard 
Connection 3 

WICED 
Enum Name 

HS5 GND_HS5       

63 BATT_MON NC  J1.9   

64 RSVD10 NC  J2.10   

65 
RSVD9 P11  J2.9  

U6.1 (SPI 
Flash – Chip 

Select) 
WICED_P11 

66 RSVD8 NC  J2.8   

67 RSVD7 NC  J2.7   

68 
RECOVER NC 

SW1 
(RECOVERY 

BTN) 
   

69 BT_UART_RXD UART_RXD  J5.1   

70 BT_UART_TXD UART_TXD  J5.3   

71 BT_UART_RTS_N UART_RTS_N  J5.7   

72 BT_UART_CTS_N UART_CTS_N  J5.5   

73 
GND_73 

VSSC1, VSSC2, 
VSSC3 

Ground    

74 
MIC_BIAS NC 

Mic (Power 
Supply) 

 MIC1**  

75 MICP NC Mic (Output)  MIC1**  

76 MICN NC Mic (Output)  MIC1**  

77 MIC_AVDD NC VDDIO    

78 
GND_78 

VSSC1, VSSC2, 
VSSC3 

Ground    

79 
EXT_LPO 

XTALI_32K, 
XTALO_32K 

RTC (J19.2)    

80 
GND_80 

VSSC1, VSSC2, 
VSSC3 

Ground    

HS6 
GND_HS6 

VSSC1, VSSC2, 
VSSC3 

Ground    

81 COL7/SPI_CS/D10 P15  J3.8  WICED_P15 

82 
COL8/SPI_MISO/D12 P17  J3.6 

U6.2 (SPI 
Flash) 

WICED_P17 

83 

ROW2/DMIC_CLK/D4 P2 
SW9.2 (DIP 

Switch) 

J4.4 (SW9.2 ON 
for Arduino- 
compatible 
Headers) 

J13.2 (SW9.2 
OFF for 

Debugger) 
WICED_P02 

84 

ROW3/DMIC_DATA/D5 P3 
SW9.1 (DIP 

Switch) 

J4.3 (SW9.1 ON 
for Arduino- 
compatible 
Headers) 

J13.4 (SW9.1 
OFF for 

Debugger) 
WICED_P03 

85 ROW4/PCM_OUT/I2S_D0/D6 P4  J4.2  WICED_P04 
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Carrier 
Module 

Pin 
Carrier Module Pin Name CYW20819 Pin 

Baseboard 
Connection 1 

Baseboard 
Connection 2 

Baseboard 
Connection 3 

WICED 
Enum Name 

86 RSVD6 NC  J2.6   

87 
GND_87 

VSSC1, VSSC2, 
VSSC3 

Ground    

88 ROW5/PCM_IN/I2S_DI/D7 P5  J4.1  WICED_P05 

89 
ROW6/SPI_MOSI/D11 P6  J3.7 

U6.5 (SPI 
Flash) 

WICED_P06 

90 
ROW7/SPI_CLK/D13 P9  J3.5 

U6.6 (SPI 
Flash) 

WICED_P09 

91 RSVD5 NC  J2.5   

92 COL0/A0 P8 J14.1 J12.1 Thermistor WICED_P08 

93 COL6/MCLK/D8 P14  J3.10  WICED_P14 

94 
GND_94 

VSSC1, VSSC2, 
VSSC3 

Ground    

95 BT_USB_DP NC   J9.3   

96 BT_USB_DM NC   J9.2   

HS7 GND_HS7 Ground  Ground    

97 
VPA_BT 

NC_0 
(PALDO_VDDIN) 

VPA_BT J16.4   

98 
VBATT 

PMU_AVDD, 
SR_PVDD 

VBATT J8.4   

99 
GND_99 

VSSC1, VSSC2, 
VSSC3 

Ground    

100 
VDDIO VDDO1, VDDO2 VDDIO J15.1, J11.2, J7.4 

J18 (VDDP- 
Peripheral 
Enable) 

 

101 BT_REG_ON NC  NC    

102 COL1/A1 NC  J12.2   

103 PUART_CTS_N/COL2/A2 P10  J12.3, J10.3  WICED_P10 

104 PUART_RTS_N/COL3/A3 NC  J12.4, J10.1   

105 COL4/PCM_CLK/I2S_CLK/A4 P12  J12.5  WICED_P12 

106 COL5/PCM_SYNC/I2S_WS/A5 P13  J12.6  WICED_P13 

107 
GND_107 

VSSC1, VSSC2, 
VSSC3 

    

108 LED4/D9 NC  J3.9   

109 LED3/D3 NC  J4.5   

110 
ROW0/BUTTON/D2 P0 

SW3 (User 
Button) 

J4.6  WICED_P00 

111 

ROW1/ARD_RST P1 

If Install position 
of R72 is in B 

position, it routes 
P1 pin 

J11.3  WICED_P01 

112 
SCL P28  J3.1 

U2.2 (Motion 
Sensor) 

WICED_P28 

113 IR_TX NC  NC    

114 
BT_RST RST_N  

SW2 (RST 
Button) 

J13.10   

HS8 
GND_HS8 

VSSC1, VSSC2, 
VSSC3 

Ground    
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Carrier 
Module 

Pin 
Carrier Module Pin Name CYW20819 Pin 

Baseboard 
Connection 1 

Baseboard 
Connection 2 

Baseboard 
Connection 3 

WICED 
Enum Name 

115 
SDA P29  J3.2 

U2.4 (Motion 
Sensor) 

WICED_P29 

116 
LED2/SPI_INT P26 

SW4.2 (DIP 
Switch) 

J1.2  WICED_P26 

117 
LED1/SF_WP P27 

SW4.1 (DIP 
Switch) 

J1.1  WICED_P27 

118 PUART_TXD/D1 P32  J4.7, J10.5  WICED_P32 

119 PUART_RXD/D0 P37  J4.8, J10.7  WICED_P37 

120 
GND_120 

VSSC1, VSSC2, 
VSSC3 

Ground    

121 RSVD4 NC  J2.4   

122 RSVD3 NC  J2.3   

123 RSVD2 NC  J2.2   

124 RSVD1 NC  J2.1   

125 
GND_125 

VSSC1, VSSC2, 
VSSC3 

Ground    

126 STATUS NC   J1.5   

127 TX_REQ/BT_SECI_OUT NC   J1.6   

128 TX_CONF/BT_SECI_IN NC  J1.7   

129 BT_HOST_WAKE HOST_WAKE  J1.4   

130 BT_DEV_WAKE DEV_WAKE  J1.3   

Table A-1. Carrier Module Interface and Pin Connections
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Related Documents 

Application Notes 

AN225684 – Getting Started with CYW20819 
Describes CYW20819 Bluetooth SoC and how to 
build your first BLE application using the device in 
ModusToolbox IDE 

Code Examples 

Visit the Cypress GitHub repository for a comprehensive collection of code examples using ModusToolbox IDE 

Device Documentation 

CYW20819 Device Datasheet CYW20819 Feature and Peripheral Guide 

Tool Documentation 

ModusToolbox IDE The Cypress IDE for IoT designers 

 

  

https://www.cypress.com/an225684
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox-1.1
https://www.cypress.com/datasheet/CYW20819
http://www.cypress.com/modustoolbox
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Worldwide Sales and Design Support 

Cypress maintains a worldwide network of offices, solution centers, manufacturer’s representatives, and distributors. To find the 
office closest to you, visit us at Cypress Locations. 

 

Products 

Arm® Cortex® Microcontrollers cypress.com/arm 

Automotive cypress.com/automotive 

Clocks & Buffers cypress.com/clocks 

Interface cypress.com/interface 

Internet of Things cypress.com/iot 

Memory  cypress.com/memory 

Microcontrollers cypress.com/mcu 

PSoC cypress.com/psoc 

Power Management ICs cypress.com/pmic 

Touch Sensing cypress.com/touch 

USB Controllers cypress.com/usb 

Wireless Connectivity cypress.com/wireless 

PSoC® Solutions 

PSoC 1 | PSoC 3 | PSoC 4 | PSoC 5LP | PSoC 6 MCU 

Cypress Developer Community 

Community | Projects | Videos | Blogs | Training | 

Components 

Technical Support 

cypress.com/support 
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